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Layers were introduced with Photoshop 3 and revolutionized Photoshop.  Layers has 
many functions and takes time to master.  Layers are not difficult once you understand 
how they function.  This document attempts to explain concepts behind layers and 
describe the features. 
 
What is a Layer? 
A layer is simply an image stacked on top of another.  Take a piece of paper and paint it 
red, then take a piece of see through material, such as cellophane, and paint an object in 
green, and lay it over the paper.  Then take another piece of see through material and 
paint red characters and place that on top of the object.  We now have a background (red) 
and 2 layers (green object, and red characters).  
 
The concept of layers is simple. Photoshop has a Layers Palette to allow you to do this 
with images.  More than one layer is many times called a composition.  Photoshop's 
layers Palette allows you do many special things to your compositions.   
 
Layer Facts 

• Layers are like overhead transparencies; you can see through areas of 
transparency where there is no visual information.  

• Each layer can have different visual information.  
• Graphical information becomes cumulative as layers are stacked, making a 

complete image.  
• Each layer can be manipulated independently.  
• The Layers Palette lists layers from top to bottom.  
• When a new image is created with a white or colored background, a new 

background is created.  
• A background is not a layer, it will show up as the bottom image in the palette.  
• An image is limited to a single background.  
• Choosing Transparency from the Contents option when creating a new image 

creates a new layer (not background) and places it as the bottommost layer in the 
palette.  

• Clicking on a specific layer within the palette selects that layer.  
• The Layer Style dialog box includes many styles that can be applied to a layer.  
• Styles can be modified by adjusting their settings.  

 



 
 

The Layers Window. 
 

• Show/Hide Icon: If the eye is showing the layer is visible.  Click on the eye - the 
layer will still be there but invisible until you click the eye again. 

• Thumbnail: A small image of the layers contents. 
• Background: Always locked, cannot be moved or have layer effects applied. The 

icon of the padlock on the right, indicates it is locked.  The background layer may 
be changed to a regular layer by double clicking on the thumbnail. 

• Normal Layer:  Where the image layer is stored 
• Layer Effects (i.e. Styles):  Special effects applied to your image.  Note the little f. 

Each effect is listed.  Multiple effects may be used at once.  
• Type Layer: The same as an image layer, except this layer contains type that can 

be edited; (Change character, color, font or size) 
 
 



 
 

The Layers Pallette 
 

• Layer highlighted – This layer is currently selected  
• Blending mode: Alters the way the layers interact.  
• Layer opacity: Adjusts the transparency of each layer. 0 is transparent, 100 is 

opaque. 
• Lock transparent: Can paint on this layer but not in transparent areas.  
• Lock Image pixels: Cannot draw on this layer if checked. 
• Lock Position: Can make changes except for moving the image. 
• Lock all: If the box is checked the layer is protected from editing. 
• Layer styles: Special layer effects. 
• Layer mask:  Allows painting away parts of layers without altering the original 

image.   “Black reveals, white conceals.” 
• Create a new set:  Allows organizing layers into folders. 
• New Adjustment layer: Allows non-destructive adjustment of colors to a layer. 

(Can be undone, even after closing a document) 
• New Layer:  Click to add a blank layer, or drag an existing layer thumbnail to 

create a duplicate Delete:  Deletes an entire layer.  Drag the thumbnail to the icon, 
or select the layer and click on the trash can icon. 



Creating Layers 
 
There are several ways to create a layer: 
 
1.  Start with the layer information provided when an image document is initially created 
and then discover other ways of creating layers.  The Contents section of the New Image 
dialog box includes buttons for selection of: White, Background Color, or Transparent.  
 

Transparent creates a new layer (not background) and places it in the Layers 
Palette's bottommost layer.  
 
Either White or Background Color creates a new background, which does not 
include functionality of layers (cannot change / adjust stacking order).  

 
2.  A background can be changed to a layer.  To convert a background to a layer: 

• Double-click the background within the Layers Palette.  
• Enter a new name for this layer.  
• Adjust color, mode, and opacity settings, if desired.  

Layer > New > Layer from Background 
 
3.  A new layer can be created by selecting a portion of an image, then via copying and 
pasting.  The copied portion becomes a new layer.  
4.   An empty layer can be created by clicking Create a New Layer (  ) at the bottom of 
the palette, or by: 

Layer > New > Layer 
6.  An empty layer can also be created by clicking the palette menu (upper right) and 
selecting New Layer.  
 
Layer Types 
 
Layers add flexibility when creating images.  There are several different types of layers 
that can be created. 

• Mask Layers — Allows special effects to be added to areas within a layer without 
affecting pixels on a layer.  The mask can be permanently applied to the layer or 
removed without impacting the layer.  

• Fill Layers — Permits a layer to be filled with solid colors, a gradient, or a 
pattern.  

• Adjustment Layers — Allows for experimentation with color. … 
 
Selecting Layers 
 
Many Photoshop images have many layers.  To edit a particular layer, that layer must be 
selected.   Once a layer is selected, changes impact only that layer.  Two ways to select a 
layer are: 

• Click the layer in the palette.  



• Select the Move Tool and place a check in the Auto Select Layer box in the 
Options Palette.  Place the cursor over an image area and click to select the layer 
with which pixels that are "clicked" are associated.  

 
Stacking Order 
 
The order layers are stacked in within the palette is important.  It determines which layer 
appears to be "on top," second, third, etc. 
  
To change the stacking order of the layers in the palette: 

• Select a layer and drag to a new location in the stack. The outline of the layer box 
moves as you drag a layer to a new location.  

• Release the mouse when repositioned.  
 
Layer Opacity 
 
Photoshop allows adjustment of a layer's transparency.  A setting of 0% sets the layer to 
transparent.  If opacity is set to 100, the layer is opaque. 
 
To adjust opacity: 

• Select the layer to be adjusted.  
• In the palette, click the arrow next to opacity ( ) to open the slider.  
• Move the opacity slider to the desired percent. The effect is visible 

 
Linking Layers 
 
Linking layers allows the selected layer to be modified and have modifications affect all 
layers linked to it.  To link layers: 

• Select layers.  
• Click Link Layers icon.  A chain link will appear on the right of linked layer's.  

 
To remove the link between layers, click on the chain link icon of the linked layers. 
 
Locking Layers 
 
Individual layers can be locked to protect their content from editing. Photoshop provides 
many lock levels. The layer lock options are found above the layer thumbnail area of the 
palette. 

• Lock Transparent Pixels (  ) 
Locks all transparent pixels within a layer and only allows colored pixels 
to change.  

• Lock Image Pixels (  ) 
Locks colored pixels within a layer and only allows transparent pixels to 
change.  

• Lock Position (  ) 
Locks the position of a layer.  



• Lock All (  ) 
Prevents changes to the layer content, but the layer's stacking order can be 
changed.  

 
Flattening Layers 
 
Images saved for use as JPG images, or GIF or for web usage, do not include layer 
information.  Images created in Photoshop and saved as GIF or JPEG must have the 
image layers flattened.  Flattening merges all layers into the background layer, which will 
generally reduce the file size.  An image isn't flattened until it is in final form.  Because 
once an image is flattened, you lose control over individual layers. 
 
To flatten layers: 

• Layers > Flatten Image 
 
In addition to flattening image layers, Photoshop provides a method to merge selected 
layers.  This is nice if you aren't ready to flatten the entire image, but feel OK with 
combining several layers into one. There are several options within the palette Menu for 
dealing with this. The options change, based on layer specifics: 

• Merge Visible - combines all visible layers. Ensure individual layers to be merged 
are visible.  

• Merge Linked - combines selected layer and layers linked to it.  
• Merge Down - combines all layers below the selected layer.  
• Merge Layer Set - combines layers within a layer set.  
• Merge Layers - combines selected layers.  

 
Transforming Layers 
 
Photoshop provides several options that can be applied to layers via Edit. 
Transformations include the following: 

• Scale — Increase or decrease size of a selection vertically or horizontally or both, 
relative to a designated point  

• Rotate — Rotates selection by rotating a selection around a reference point  
• Skew — Skews selection by slanting it vertically or horizontally  
• Distort — Distorts selection by stretching in all directions  
• Perspective — Changes perspective of selections  
• Rotate 180° — Rotates selection 180 degrees  
• Rotate CW 90° — Rotates selection clockwise 90 degrees  
• Rotate CCW90° — Rotates selection counter-clockwise 90 degrees  
• Flip Horizontal — Flips selection horizontally  
• Flip Vertical — Flips selection vertically  

 
IMPORTANT: The first five Transformation options place a reference point in the center 
of a selection.  As well, a bounding box (looks like handles) is placed around the 
selection 



 
 
To transform a layer or a selection from a layer: 

• Select the layer or selection to be transformed.  
• Choose the transformation type:  
• Edit > Transform > select the transformation option 
• Set a reference point by selecting the desired point from the Reference Point 

Location area (  ) of the Transformation.  

 
 
 
Layer Styles 
 
Layer styles are special effects that may be applied to a layer.   Photoshop provides many 
styles including: drop shadow, inner shadow, outer glow, inner glow, bevel and emboss, 
satin, color overlay, gradient overlay, pattern overlay, and stroke.  These styles are 
available via Layers menu or the layers palette.  When a style is applied, the style name 
appears in the palette below the name of the layer.  
 
Each of the styles have default settings.  Settings can be adjusted via the Layer Styles 
window.  To apply a layer style: 

• Select the layer to which the style will apply.  
• Click-add a Layer Style (    ).  
• Choose the layer style.  
• Confirm or adjust settings.  

 
 



Blending Layers (Blend Mode) 
 

Photoshop has 23 different ways to mix the pixels of an active layer with the layers below 
it. These are known as the Blend Modes. With this many modes we will never remember 
them all so we will only look at a few for now that are commonly used and easy to 
remember. 
 

 
 

Choosing blend mode from Layers Palette 
 

• Normal – is the mode that we have shown so far. The only place where you 
see anything from the layers below is where the opacity is less than 100%. 

 
• Multiply Mode is probably the worst of the names of any blend mode because 

it is not intuitive what it does. The Multiply blend mode is the same as making 
a montage of two slides and then projecting them. Any place on the slide 
which is clear all of the light gets through. Any place that is dark blocks the 
light. As a result any area that is light in both the active layer and the layer 
below stay light. Any are of the slide that is dark will make the final image 
darker. 

 



 
 

Normal                                                     Multiply 
 

Notice the light areas stay bright but shaded areas get darker. 
 

• Screen Mode is a name that makes it easy to remember. Picture having two 
projectors side by side shining on the same screen with the active layer in one 
projector and the background in the other. Bright areas will not get any 
brighter and the darker areas will get lighter.  

 

 
 

Normal                                                 Screen 
 

The dark areas have gotten a lot lighter. 
 

• Overlay Mode can be thought of as a mix of Multiply and screen. This mode 
does the equivalent of Multiply mode to the dark areas and Screen mode to the 
light areas, The lighter areas will get lighter, while the darker areas will get 
darker. 

 

 
 

Normal                                 Overlay 
The lights have gotten lighter and the darks are darker. 



 
• You can have different images in the layers so your imagination is the only 

limit on how you can use blend modes creatively. You can create montages of 
images with of kinds for different effects. 

 

 
 

Image                                                   Foil                                         Overlay 
 

 
 

The same image and foil using the Dissolve blend mode. 
 

 
 

This image has a background, a copy of the background that has been 
blured and mixed with the multiply blend mode. 

 
The best way to learn how to use blend modes creatively is to play with them seeing 
what effects you can create. 


